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Compatibility Checklist

Thank you for choosing CompuLEAD Desktop Pro, the leading computer-based
lead management solution for exhibitors. This is a checklist that contains all the
necessary information that you will need to set up the computer that you will be
using at the show to work with CompuLEAD Desktop Pro.

Please make sure you are able to successfully complete every item on the
checklist BEFORE you get to the show. If you are not able to do so, please
contact an Exhibitor Service Representative immediately at 708.786.5565 —
option 3.
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I understand that if I am unable to successfully complete every item on this
checklist that CompuLEAD Desktop Pro may not function properly.

I understand that CompuLEAD Desktop Pro requires a computer.

I understand that a computer IS NOT included with my CompuLEAD Desktop
Pro purchase, and that | have to bring a computer to the show.

My computer has a CD-ROM drive.

My computer is running Windows 2000, XP, or Vista 32-bit version only
(not compatible with Vista 64-bit version).

My computer has a Pentium Il processor or faster.
My computer has a SVGA monitor with a 800 x 600 resolution.
My computer has at least 256 MB RAM.

I successfully installed the LEADLInk Plus! lead management software
(included) on the computer that | will be using at the show.

I successfully installed the CompuLEAD 11 Driver (located on CD-ROM) on
the computer that I will be using at the show.

My computer has an open USB port.

If you have questions about any of the items on this checklist, you can contact our
technical support line at 708.786.5565 — option 3.
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Installation

The LEADLInk Plus! installation will automatically run when you place the CD-ROM in
the drive. If not, using the Start Button, select Run and browse to your CD-ROM
drive. Select “Double Click Here to Launch” and click open. Now click the OK
button. The installation menu will start and you will see four options.

=3 LEADLink Plus Installation

| |tiztall LEAD LRk Plus |

\ Compublead |l Dnvers |

\ Ingtallation [nstrachons |

\ it |

LEADLink Plus
Installation

Choose “Install LEADLink Plus” first.

The installation program will ask you to be sure that all other programs are shut
down. Once complete, click the Next button. Next it will ask you to select the
Destination Folder, unless you have another program with the same name and in the
same folder, use the default destination and click the Next button. The last screen
will let you know that the installation process is complete, click the Finish button.
There will now be an icon for LEADIink Plus! On your Desktop. To start the
application, double click the icon.

» NOTE!! The first time you start the application, a Welcome screen will pop up
and ask for a Release code. If this is the first time you have loaded this
application onto this PC, just click OK. If you have loaded this software on
this PC at a prior show, you will need the release code to use this application.
Use the instructions on the Welcome screen to receive your Release code.

» NOTE!! The user license is for 30 days after you install the application. Be
sure to Export your leads before the end of the 30 day period.
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Once installation of LEADLink Plus! has completed, choose “CompulLEAD Il Drivers”.

%# LEADLink Plus Installation

‘ whindows #PAizta Driver ‘

‘ Windows 2000 Driver ‘

‘ b ain b eru ‘

‘ Cluit Installation ‘

LEADLink Plus
Installation

If your computer runs on Windows XP or Vista 32-bit version only (not compatible
with Vista 64-bit version), choose “Windows XP Drivers”. If your computer runs on
Windows 2000, choose “Windows 2000 Drivers”. The drivers are necessary for the
CompulLEAD 11 to interface with the LEADLink Plus! software.

NOTE: If you do not have administrator rights to your computer, you will need to
seek your system administrator before installing these drivers.
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Upon choosing an installation, XP, Vista or 2000, a warning box with be appear:

Software Installation

L | "_\ The software you are installing hasnot passed Wirdows Logo
L& teating to verfy its compatibifty with Windows XF . (Tell me why
thiz testing i imporant.

Continuing your installation of this software may impair
or destabilize the comect operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop this instaliation now and
contact the software vendor for software thal has
passed Windows Logo testing.

Cortinue Amyway J [ STOF Inatalistion

Choose “Continue Anyway”. A second similar box will be presented, choose
“Continue Anyway” again. This will happen two additional times. Choose “Continue
Anyway” each time. When finished you will see the following:

Yirtual Com Port Setup

L
- | ) The virtial com port device driver files were successfully installed on your computesr]

Click “OK”.
You may then “Quit Installation” or return to the main menu for other options.
Note: After installation, the CompuLEAD Il may not be recognized.

Therefore, it is recommended that you restart your PC before scanning any
badges.
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Setup Your LEADLINnk Plus! System

The setup should be done before the Event and should have just one person
designated as the “Administrator”. The Administrator will have the password for
setting up the application and for making changes to the standard Qualifiers and
Survey Questions, as well as entering Products if desired. To prevent unauthorized
changes to the settings, the Administrator should control access to the password.

To Start the LEADLink Plus!, double click the LEADLink Plus! Icon on your desktop.
You will see a warning box appear on the screen. Please click “OK”, it will happen 4
times. This error occurs because you do not have a CompuLEAD Il connected to
your computer or the correct COM port was not chosen.

1) To setup the database for the show, the Administrator should go to the Menu Bar
and select Setup. Then select Administrator Mode and enter the password csi.
The Menu Bar will now show additional choices.

a) Name your Show’s database:
)] In the File Menu, click “Save As” and Type in a name that will
identify the Event you are using LEADLink Plus!
ii)  Then in the File Menu, click “Open” and select the database name
you just entered. This will now become the default database
every time you start the application.

b) Customize the Show Information Page:
i In the Setup Menu, click the “Show” button and then the “Show”
tab and enter the information for your Event.
ii)  When you are finished, click the “Save” button.

c) Customize the Qualifiers:

)] In the Setup Menu, click “Show” and then the “Qualifiers” tab.
Review the Standard Qualifiers to see if they meet your needs.

ii)  To edit the current Qualifiers, click on the text of the Qualifier
you want to change and type in the new text. Continue until
finished, click the “Save” button.

iii) To Add new Qualifiers, click the Add button.

(1) As before, click on the text of the new qualifier and type in
the new text.

(2) Now click on the corresponding code and enter the next
sequential number (i.e. 11,12...). Continue until
complete, then click the “Save” button.

iv) To delete Qualifiers, highlight the Qualifier and click the “Delete”
button.

(1) Note: Do not delete Qualifiers once you start using
LEADIink Plus!. Deleting will remove that Qualifier from all
records.

d) Customize the Products:
i In the Setup Menu, click “Show” and then the “Products” tab.

Version 1.3 Page 7 of 19
Copyright © CompuSystems, Inc. Proprietary and confidential.



LEADLInk Plus! Installation Instructions

ii)  To edit the current Products, click on the text of the Product you
want to change and type in the new text. Continue until finished,
click the “Save” button.

iii) To add a new Product, click the “Add” button.

(1) As before, click on the text of the new Product and type in
the new text.

(2) Now click on the corresponding code and enter the next
sequential number (i.e. 11,12...). Continue until
complete, then click the “Save” button.

iv) To delete Products, highlight the Product and click the “Delete”
button.

(1) Note: Do Not delete Products once you start using
LEADLInk Plus! Deleting will remove that Product from all

records.
e) Customize the Survey Questions:
)} In the Setup Menu, click “Show” and then the “Survey Questions”

tab.
ii) To add a new Question, Click the “Add” button on the top
windowpane.
(1) Click on the Name of the question and give it a short but
useful name (i.e. Purchase Authority, Number of Emps).
(2) Click on the text of the Question and type in the question
as you want it to appear on the screen (i.e. What is your
Purchase Authority, What is the Number of Employees at
your Company).
(3) Click on the Selection type and choose between a Multi
Answer or Single Answer Question.
(a) A Multi answer question allows you to select as
many answers as you like.
(b) A Single answer question allows you to select only
one answer for the question.
iii) To add the Answers to the Question you just entered, click the
“Add” button in the Choices windowpane.
(1) Click on the text for the choice and enter in the text for
the Answer. Keep the answer as short as possible, as this
is the data stored (i.e. Recommends, Final Approval, 1-
100, Over 100%...).
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Re-Use Your Custom Settings:

If you have purchased LEADLink Plus! at a previous Show and you have purchased
the service at your current Event, you can re-use all of the custom information. The
designated “Administrator” can use the password to enter the Administrator mode.
After you have saved the database under the new name and have made it the
default database, you can clear out all of the previous Show’s contact information to
start out fresh. In the Edit menu, click “Purge All Contacts”.
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CompuLEAD Il COM Port

This step can not be accomplished until you receive your CompuLEAD Il rental at the

show.

1. Compul EAD |1l Installation

PNOUALNRE

9.

Turn on CompulLEAD II

Connect USB cable to the USB port on the back of the CompuLEAD II
Connect the other end of the USB cable to the USB port of your PC
Read a badge to open the Virtual Serial Port on the CompuLEAD 11
Select “No, not this time” and then click “Next”

Select “Install from a list or specific location” and click “Next”

Select “Include this location in the search” and then click “Browse”
Browse and select the directory where the drivers are located and then
click “OK”

Click “Continue anyway”

10. Click “Finish”

11. Determining and Setting the COM Port

1.

2.

Click on your [Start] button.

‘4 Start

From the items that appear, click on [Control Panel].

SEN Microsoft Office Excel 2003

.l-" Conkrol Panel
i

Mokepad Set Frogram Access
ﬂ @ Defaults
% Yahoo! Messenger e__«, “onnect To

|';,.;g Printers and Faxes
OWT-Term
EEEEEEEH

t!) Help and Suppart
§ %4 Microsoft Office Visio 2007
'.) Search

All Programs D E Run...

2 start
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3. Click on [Performance and Maintenance].

Pick a category

r = -
% Appearance and Themes Printers and Other Hardware
« ~=

Network and Internet Connections 4 User Accounts

? Add or Remove Programs - Date, Time, Language, and Regional Options

e Sounds, Speech, and Audio Devices Accessibility Options
<9 e

_'- Performance and Maintenance Security Center

4. Next, click on [System].

Pick a task...

E| see basic information about your computer
[®) adjust visual effects

E| Free up space on your hard disk

E| Back up your data

E| Rearrange items on your hard disk to make programs run faster

or pick a Control Panel icon

”]“1' Administrative Tools | owet Dptions

ﬁ scheduled Tasks TI System

5. From the System Properties page, click on the [Hardware] tab. (If
you're using Vista, click on Advanced System Settings to get to the
System Properties page.)

System Properties

| Syztem Restore || Automatic Lladabas Remote |
General | Computer Name Advarced |

Syztem;
ticrozaft Windows <P
Professional

". Version 2002

Service Pack 2

6. In the Hardware tab, click on the [Device Manager] button.
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System Properties

Syztem Restore Automatic: Updates Remote
General Computer Mame Hardware Advanced

Dievice Manager

The Device Manager listz all the hardware devices installed
- on pour computer, Uge the Device Manager to change the

properties of any device.
‘ [ Device Manager ] )
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to see its sub-values.

= =) C51-010990357
_.& Campuker
g Disk drives
é Cisplay adapters
ity DVDYCD-ROM drives
[i#g Human Interface Devices
=% IDE ATA/ATAPIL contrallers
e Kevboards
%y Mice and other pointing devices
& Moritors
BE& MNetwork adapters
B Broadcom 302,119 Nebwork Adapter
B8 NYIDIA nForce Metworking Controller
LY IO, T
N FILILE Ll

. sound, video and game controllers

System devices
Universal Serial Bus contraollers

Ea e e e e R e e e R

F-[F- [

7. From the Device Manager list, double-click on [Ports (COM & LPT)]

Among the ports listed, you’ll see [USB to Virtual COM Port
(COM<x=>)] listed (where “<x=>" will be the numbers 1, 2, 3, or 4.

- B} CSI-010990357
¢ Computer
o Disk drives
j Display adapters
ity DVDYCD-ROM drives
g Human Interface Devices
i=%) IDE ATAIATAPT controllers
s Kevboards
%y Mice and other pointing devices
& Moaritors
BE Metwork adapters
B8 Broadcom 502,110 Metwork Adapter
BE MVIDIA nForce Metworking Controller
\> MWIDIA Metwork Bus Enumerakor
n_bf Pork= (OO 2 I PTY

" 1USE to Yirtual COM Part (COM3)
P '

e I
. sound, video and game controllers

Syskem devices
Iniversal Serial Bus controllers

- [ o ] o [ [ [ < )

+

+- [ [ [F

In this example, the PC has defaulted to COM3. You'll want to
remember this for later. Close the Device Manager and Control Panel.
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8. Start your LEADLInk Plus! software by double-clicking the icon on your
Desktop.

El
LEADIinkFIs

9. If you had a previous version of LEADLink Plus! application, you’'ll see
a welcome screen. Notice the license expiration date; if this date has
passed, you’ll need to contact technical support in one of the ways
noted on the screen.

Welcome to LEADLink Plus!

LEADLink Plus! license type = 30 Day Demo Version
[The license expires in 30 days. on 10/19/2007 |

To enable for purchase or an extended demo. please contact any of
the three sources below with your name. company. and Computer 1D
{see box below) and we will return a security release code within two
business days.

1. Email CompuSystems. Inc. at support@compusystems.com
2. Fax CompuSystems. Inc. at (708) 344-9487
3. Call CompuSystems. Inc. at {708) 486-0777

[Or Press <OK or Cancel> to continue with the application ]

Computer 1D |21 41486593
™

Enter Release Code
[then hit OK) | ' _ I Cancel

Once you receive the Release Code, enter it in the Enter Release Code
field then click on [OK]. (If you've never installed LEADLink Plus! on
this PC, you won'’t see this screen.)

10. If your default COM port doesn’t match what LEADLink Plus! is looking
for, you’ll get an error message. Click [OK].

Error in routine CommApplyParameters EJ
L] "_-. Imvalid port number
L
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11.You’'ll get another error message. Click on [OK]. These two error

messages may continue several more times; click on [OK] each time
until the error messages stop.

'. Praoblem setking up comm parameters For this card reader:
Compu3ystemns Compulead

12.The main LEADLIink Plus! screen appears.

=* LEADLink Plus! - Show.mdb - (Mo Profile)

File Edit Setup Help

LEADIink

Ready - (0 Contacts]

Expand All Save |
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13. From the top menu bar, click on [Setup] then on [Com Port].

Corm Port 2
Corm Port 3
Corm Port 4

15. Remember the Com Port that you saw in the Device Manager screen
(recall that the PC used in this example is set-up for COM3.) Click on
that Com Port number in the drop-down list.

| =* LEADLink Plus! - Show_SLB.mdb - {No Profil
File Edit BeENs

Administrakor Mode
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16. A new icon appears at the bottom of your display. Click on it.

& BadgeLink - Wersion 1...

This shows your BadgeLink application is set to read a CompuSystems
CompuLEAD device.

4" BadgeLink - Version 1.10.3

Badge Reader

Select Current Reader [1 Reader Definitions Loaded]

Resat

Fieader Description Debua Info

CompuSystems Compulead

C:ALEADlinkPlus\Program\CompuSystems Compulead. RDF
Version 5/17/2001

Reader For CompuSystems CompulLEAD reader

Tested for BadgeLink 1.9.3

[insttr i |

Add Mew Reader.. | Edit Curent Reader... | Test Scan

Ready

Your COM port set-up is complete. Please reboot your PC to before scanning any
badges.
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Use of LEADIink Plus! at the show

1) To Start the application, double click the LEADIink Plus! Icon on your desktop.
With the CompuLEAD unit attached and turned on, insert the badge (with the
code facing you). The CompuLEAD unit will beep after a good scan and the data
will then populate the fields on the screen. You can then Qualifier your lead,
Scan another badge, or click Save.

2) To Qualifier your leads, select any of the choices from the navigation window on
the left side of the screen (i.e. Qualifiers, Products, Survey Questions). The
Qualifiers and Survey Questions are setup with our LEADIink Plus! Defaults, but
the Products will have to be setup by you if you wish to use them.

3) To Select a Qualifier, click on the appropriate Qualifier(s) check box to select or
deselect your choices. When you are done, you can navigate to Qualifiers or
Surveys, return to the Contact Information, or you can click Save.

4) To Enter a Product, click on the appropriate Product(s) check box to select or
deselect your choices. When you are done, you can navigate to Products or
Surveys, return to the Contact Information, or you can click Save.

5) To Answer a Survey Question, click on the appropriate Survey Answer(s) check
box to select or deselect your choices. When you are done, you can navigate to
Products or Qualifiers, return to the Contact Information, or you can click Save.

6) To Export your leads, click on the File menu and select Export Leads on Disk.
The select a destination drive and directory, its name, and the date range you
want to include in you download. (To download one day’s leads, just use the
same date for the start and end dates).

7) To Exit the application, click on the File menu and select exit. All of your leads
are saved as you scan a new badge, move to a different screen, or click save.
(Whenever you finish with a lead and you have no one else to scan, click the
Save button).

If you have any technical support questions,
please contact a Representative at
708.786.5565 — option 3
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